
 

MicroMax   GPS80 Interrupter
Installation and Configuration Guide

®





AMERICAN INNOVATIONS, LTD.

MicroMax ®  GPS80 Interrupter
Installation and Configuration Guide

©American Innovations, Ltd.
http://www.aiworldwide.com/

12211 Technology Blvd • Austin, TX 78727
Phone: 512-249-3400 • Fax: 512-249-3444

http://www.aimonitoring.com/
http://www.aimonitoring.com/
http://www.aimonitoring.com/


Information in this document is subject to change without notice.

© 2009 American Innovations, Ltd. All rights reserved.

Reproduction in any manner whatsoever without the written permission of 
American Innovations is strictly forbidden.

Trademarks used in this text: the American Innovations logo and icon are 
trademarks of American Innovations, Ltd. The MicroMax logo and icon are 
registered trademarks of American Innovations, Ltd. 

Other trademarks and trade names may be used in this document to refer to 
either the entities claiming the marks and names or their products. American 
Innovations, Ltd. disclaims any proprietary interest in trademarks and trade 
names other than its own.

August 7, 2012 Part No. 122096-000, Rev. 5



C h a p t e r  1

Getting Started

Introduction
The MicroMax® GPS80 Interrupter is a programmable, GPS current 
interrupter. The information in this guide is intended for authorized 
service personnel who plan to install and configure the interrupter for 
service using the MicroMax GPS80 Interrupter Programmer software. 

GPS80 Interrupter Overview
Rectifier interruption in the cathodic protection industry requires an 
accurate on-board clock with minimal drift to ensure synchronization 
between multiple interrupters over extended periods of time. 
Traditionally, quartz crystal clocks are used but with the availability of 
GPS technology, the use of GPS receivers to ensure a highly accurate 
clock with zero drift has become the standard. 

The GPS80 interrupter is a GPS synchronized current interrupter that is 
ideal for any interruption task. The device measures 5.5 inches x 3.5 
inches x 1.25 inches and includes standard connections for 12V power, 
antenna, switch control, programming interface, and interruption 
activation/deactivation. It is an ideal solution for portable or permanent 
installation applications. See the figure on the next page for an example of 
the GPS80 interrupter. 
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Figure 1.  GPS80 Interrupter

You can use the GPS80 interrupter in any of the following 
configurations:

 As a stand-alone portable interrupter that is small enough to fit 
inside any rectifier. It is capable of controlling almost any relay 
requiring a 0V/12VDC control signal.

 As a permanently installed interrupter inside a rectifier either as a 
retrofit or for OEM applications. The GPS80 interrupter can be 
activated manually or via a telemetry application. 

 Packaged in a weatherproof portable case with backup batteries 
and with an optional built-in 60A mechanical relay.

 Interfaced with the Bullhorn® ICP (a satellite remote monitoring 
unit) for remote activation of an interruption cycle and alarm via 
e-mail or cell phone if interruption fails. The ICP is available as a 
robust, portable field unit or as a permanently installed unit. 

The GPS80 interrupter includes the following features:

Serial
Communications

GPS Antenna

Power

Relay Switch

DB15 for
Programming
Selection Key

Status LEDs

SYSTEM
PROGRAM 1
PROGRAM 2
PROGRAM 3
PROGRAM 4
GPS
POWER
OPER
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 GPS receiver and on-board clock that is updated every 15 
seconds.

 On-board CPU with algorithm to achieve synchronization 
between multiple units.

 Fully programmable in 0.1 second increments (up to 99.9 
seconds) for any on/off cycle combination.

 Four user-defined interruption cycles stored in memory.

 Digital inputs and outputs allowing control and status 
verification.

 Serial communications port for programming and monitoring.

 Signal output to operate almost any relay with 12VDC control.

You can use the GPS80 interrupter as a stand-alone portable device or as 
a permanently installed device. The supplied DB15 programming 
selection key (also called dongle key) allows you to activate any of the four 
interruption cycles. Alternatively, the interrupter can also be controlled 
and monitored by most systems that provide at least one discrete output. 

The GPS80 interrupter is provided with 4 discrete inputs (used to select 
any one of 4 interrupter programs) and discrete outputs that indicate 
program, operation, power, and GPS satellite status. Up to 4 interrupter 
programs are simultaneously present on the GPS80 interrupter. 
Depending on the capabilities of the third party equipment, any one of 
these 4 programs can be activated. 

The MicroMax Programmer is a Windows-based, configuration software 
that allows you to create an interrupter configuration file and then 
download the file to the GPS80 interrupter. You can configure 
interruption cycles using any combination of time intervals between 0.1 
seconds and 99.9 seconds for Off and On cycles. The MicroMax 
Programmer also allows you to configure the GPS80 interrupter with a 
variety of switches and synchronization configurations; open and closed 
switch configurations are both supported. Every setting and parameter is 
saved in the configuration file for download to the GPS80 interrupter or 
later retrieval.

Synchronization configuration allows the GPS80 interrupter to operate 
with almost any other brand of GPS synchronized interrupter or logger. 
The GPS80 interrupter can be configured to accommodate other brands 
of interrupters using non-standard configurations. Based on the number 
of GPS satellites seen and the quality of view, synchronization triggering 
accuracy is specified to within 1µs with any other MicroMax interrupter. 
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Mercury Relay Customer Advisory
This advisory is intended to notify American Innovations (AI) customers 
of the manufacturer’s published limitations on mercury relays. 

Customers primarily purchase relays from AI for use with the 
MicroMax® family of current interrupters. MicroMax interrupters 
provide great programming flexibility to enable customers to use a wide 
variety of interruption cycles. 

AI supplies mercury relays from a variety of respected and reliable 
vendors including MDI and American Electronic Components (AEC). 
These manufacturers publish expected relay lives of 3 to 6 million cycles 
depending upon the type of relay selected. AEC, the manufacturer of 
Durakool relays, indicates that relay life will be significantly shortened at 
rates exceeding 1,500 cycles per hour. MDI recommends no more than 
900 cycles per hour. Depending upon the interruption cycle chosen by 
the customer, it is possible to exceed the manufacturer’s recommendation 
resulting in a likely reduction of service life. 

As an example, customers who elect to use mercury relays to interrupt at 
1 cycle per second will generate 3600 cycles per hour. Customers should 
consult the manufacturer’s documentation to select the appropriate relay 
for the application. Durakool information can be accessed via the 
Internet at the web address below:

http://www.aecsensors.com/ 

In the Durakool documentation, two situations are explained that may 
impact the current carrying capacity of the relay: 1) cycle rate and 2) 
voltage values. The sizing tables indicate a methodology for determining 
the maximum amperage that can be carried depending upon the cycle 
rate. An additional de-rating table for mercury relays is provided for those 
instances where voltage in excess of 48 VDC is being interrupted. When 
selecting relays, customers should be aware of both of these de-rating 
tables to choose the best relay for the application. 

To avoid depolarization of the CP system, the mercury relays that AI sells 
are of the normally closed variety. It is possible that a normally closed 
relay will fail at the end of its life in the open position due to a 
malfunction of the spring mechanism which drives the plunger/contacts 
into a normally closed position. If this occurs, a depolarization situation 
would result. AI has the following two recommendations: 
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 Customers using mercury relays should consider periodic 
replacement of these relays based upon engineering estimated life 
via a preventive maintenance program to reduce the likelihood of 
an open circuit failure. 

–OR– 

 If fast cycle operation is common, AI recommends a solid state 
relay for maximum life and reliability. 

Although the MicroMax interrupter is capable of being programmed for 
faster interruption cycles, AI recommends that customers not exceed 900 
cycles per hour (or a cycle time of less than four seconds) and will not 
warranty devices that are utilized in this manner. AI adds a serial number 
to relays that are supplied to enable the tracking of the shipment date. 
The approximate age of the relay may be used to assist AI in return 
material response, failure analysis, and warranty claims. AI will also 
consult manufacturers to help determine failure cause and advise 
customers that warranties may not be honored if AI or the manufacturer 
deems that the mercury relay is used outside of recommended 
parameters. 

If you have questions or need additional information, please contact AI 
Technical Support. 

Using the GPS80 as a Stand-alone 
Interrupter
The GPS80 interrupter is designed for permanent installation inside a 
rectifier (with or without remote monitoring) or for use as a portable field 
device. The GPS80 is not waterproof and because of its small size, should 
always be left inside the rectifier cabinet. 

The provided 110V power adapter supplies 12V DC power to the GPS80 
interrupter. GPS synchronization is achieved with the provided GPS 
antenna. The GPS80 interrupter is pre-programmed with four interrupter 
programs. For more information about interruption settings and factory 
default settings, refer to pages 11 and 12. 
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All GPS80 interrupter functions are monitored with 8 LEDs visible on 
the front panel of the device. (Refer to Table 1.) You can activate 
interrupter programs 1, 2, 3, or 4 by plugging the provided selection key 
(dongle key) in the DB15 port on the GPS80 interrupter and then setting 
the DIP switch on the selection key to 1, 2, 3, or 4. To connect the 
external relay, plug the male banana plugs on the switch control cable in 
the female jacks on the GPS80. See Figure 1 on page 2 for location of 
connectors. 

Table 1.  GPS80 Interrupter Status LEDs

LED Name LED Description

System Blinks in synchronization with PPS signal (precise 
positioning service signal) obtained from GPS 
constellation. 

Program 1 Blink: Calculating or standby (see Notes). 
Solid: Program 1 activated. 

Program 2 Blink: Calculating or standby (see Notes). 
Solid: Program 2 activated. 

Program 3 Blink: Calculating or standby (see Notes). 
Solid: Program 3 activated.

Program 4 Blink: Calculating, standby, or always “off” program 
(see Notes). 

Solid: Program 4 activated.

GPS Lights when sufficient satellites are visible for 
accurate clock update. 

Power Lit when power is on, not lit when power is off. 

Oper Lit when output is 12V. 

Notes:

Calculating:The period from activation of the program by the user 
until the unit is ready to start the first “on” or “off” part of the interruption 
cycle.
Standby: When an interruption program is selected, but the current 
time is outside the times set for the interruption (daily schedule). For 
example, interruption is set to run from 06:00 to 18:00 (6pm) every day 
but it is currently 21:00 (9pm). 
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Powering Up the GPS80 Interrupter
Complete the following steps:

1. Plug the 110V adapter in a 110V electrical outlet. Plug the other 
end of the adapter (DC plug) in the jack marked 12V DC on the 
GPS80 interrupter. See Figure 1 on page 2 for location of the jack. 

When power is applied to the GPS80 interrupter, the green LED 
labeled Power illuminates. 

2. Plug the GPS antenna in the jack labeled GPS on the GPS80 
interrupter. Place the antenna where it has a clear, unobstructed 
view of the sky. 

After approximately 30 seconds, the amber System LED begins 
flashing. If the LED is not flashing, leave power on for 15 minutes. 
If after 15 minutes the LED does not begin flashing, recycle power 
to the GPS80 interrupter. If the System LED does not begin 
flashing at this point, please contact Technical Support for 
assistance. 

3. After the GPS80 interrupter locates the GPS satellites to update its 
clock, the amber GPS LED illuminates. This process may take a 
few minutes and only occurs after the System LED has begun 
flashing. 

Installing the Relay
Complete the following steps:

1. Before you begin, make sure to observe all safety precautions 
during the relay installation. 

NOTE: For important information about mercury relays, refer to 
the section entitled Mercury Relay Customer Advisory  on page 4. 

2. The GPS80 interrupter operates almost any relay requiring a 
0V/12VDC control signal. If a mercury relay is used, make sure 
the relay is oriented upright with the cylindrical body of the 
relay in a vertical position. The label on the relay should face up 
so that the lettering is readable. 

NOTE: If the relay is normally open (NO) or normally closed 
(NC), refer to Chapter 2, Configuration on page 15 for information 
about how to set up the GPS80 interrupter for either a normally 
open or normally closed relay.
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3. Connect the relay switch to the red and black female banana 
connectors labeled Switch on the GPS80 interrupter. Make sure 
the polarity is correct. See Figure 1 on page 2 for location of the 
connectors. 

NOTE: The solid state NC relay requires a minimum switching 
load of 24V AC.

4. Turn On power to the rectifier and then power-up the GPS80 
interrupter.

5. Verify that the process described in the previous section occurred 
(Powering Up the GPS80 Interrupter  on page 7). After the GPS LED 
illuminates, you can start the interruption cycle. 

Starting an Interruption Cycle
Complete the following steps to start interrupter program 1, 2, 3, or 4:

1. Insert the selection key in the DB15 port on the GPS80 interrupter. 
See Figure 1 on page 2 for location of the port. 

2. Slide the corresponding DIP switch (1, 2, 3, or 4, respectively) to 
the left (on). 

For example, to start program 1, slide DIP switch 1 to the left. 

The green LED for the corresponding interrupter program begins 
flashing. This indicates the GPS80 interrupter is calculating the 
exact point that it can start the interruption cycle. As soon as the 
interruption cycle begins, the green LED remains lit and then the 
amber LED labeled Oper illuminates when the 12V control signal 
is applied to the switch. The amber Oper LED turns off when 0V 
is applied to the switch. 

3. To stop the interrupter program, slide the DIP switch to the right 
(off) or remove the selection key (dongle key). 
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Using the GPS80 with a Third Party Device
This section explains how to use the GPS80 interrupter with a third-party 
control instrument such as a remote terminal unit (RTU). For successful 
operation, the GPS80 interrupter requires the following input/output 
configuration:

 12V power supply

 One digital control channel (to activate/deactivate programs)

 Rectifier switch (any 12V controlled switch)

 GPS antenna 

The GPS80 interrupter includes the features listed below. Also refer to 
the next table (Table 2) and Figure 1 on page 2. 

 Supports 4 control channels for selecting a specific interrupter 
program. Also supports open-collector configuration and level-
control. 

 Program 4 can be configured as “Always off” in support of 
turning the rectifier off for an extended period of time. 

 Status channels support 4 programmable interruption cycles. 
They also support power, GPS satellite, and interrupter output 
status. 

 LEDs are provided for all status channels.

 All control and status channels are accessible using the DB15 
connector on the GPS80 interrupter. 

 GPS antenna connects to the GPS80 interrupter using a MCX 
connector. 

 The GPS80 interrupter is programmed and monitored using a 
banana plug that connects in the jack provided on the side or 
bottom of the interrupter. 

Table 2.  GPS80 Interrupter Technical Specifications

Description Typical Min. Max.

Supply Voltage 12V 10V 15V
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Current consumption, 
excludes current 
consumed by external 
switch

100 mA

Current supply to switch 
at 12V, dependent on 
12V source capacity

500mA

Open collector 
configuration 
(All status channels, 
Operation, and 3D Fix)

25V
100mA

Physical Size
(height, length, width)

1.34in. x 5.5in. x 3.66in. 
(34mm x 140mm x 93mm)

Table 2.  GPS80 Interrupter Technical Specifications

Description Typical Min. Max.
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Information in the next table identifies the pin configuration of the DB15 
connector (input for program selection key). 

NOTE: Interruption cycles can be initiated manually by shorting pin 10 
(GND) to the relevant input pin (pin 8, 15, 7, or 14 for interrupter 
programs 1, 2, 3 or 4, respectively). Interruption starts after the 
interrupter has completed calculations for synchronization, which takes a 
few seconds. 

Interruption Settings
A number of options are available when setting interruption parameters. 
Refer to the following table for a description of available options. 

Table 3.  DB15 Pin Configuration

Pin Description

1 Power on Indication (Hi impedance output)

2 Satellite OK

3 Output confirming Program 4

4 Output confirming Program 2 

5 Auxiliary output (not used)

6 Auxiliary output (not used)

7 Input 3 (activate program 3)

8 Input 1 (activate program 1)

9 Output monitor (indicates 12V/0V of interrupter output 
connector)

10 GND

11 Output confirming Program 3

12 Output confirming Program 1 

13 NU

14 Input 4 (activate program 4)

15 Input 2 (activate program 2)
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GPS80 Interrupter Default Settings
The next table identifies factory default settings for the GPS80 
interrupter. If you are a third party user, default settings may have been 
changed by your provider. 

All interruption parameters are configurable using the MicroMax GPS80 
Interrupter Programmer software provided on the CD in the installation 
kit. The software allows you to monitor the device and change 
interruption settings. For more information about the software, refer to 
Chapter 2, Configuration on page 15. 

Table 4.  Interruption Options

Parameter Possible Settings

On Time  0.1 – 99.9 seconds
 Increments of 100 milliseconds

Off Time  0.1 – 99.9 seconds
 Increments of 100 milliseconds

Scheduling  Start immediately, never stop
 Daily, set between start and 

stop times
 Between two dates, daily 

between start and stop times

Synchronization  On/Off
 Off/On

Output Level 
(to support various switches)

 Low level (0V) is ON (for 
normally closed switch)

 High level (12V) is ON (for 
normally open switch)

Time Zone GMT –12 to GMT +12

Table 5.  GPS80 Interrupter Factory Default Settings

Setting Description

Time Zone GMT
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Contacting Technical Support
If you need assistance with the GPS80 interrupter, please contact 
American Innovations (AI) Technical Support in any of the following 
ways:

Telephone: 512-249-3400
800-229-3404

Email: bhtechservices@aiworldwide.com

Mail: American Innovations, Ltd.
ATTN. Technical Support
12211 Technology Blvd.
Austin, TX 78727

Fax: 512-249-3444

On/Off Interruption for 
Programs 1 – 4

On/Off times listed below are in seconds: 

 Program 1: 9.0 / 3.0
 Program 2: 12.0 / 3.0
 Program 3: 4.0 / 1.0
 Program 4: Output always high (12V) 

(Used in advanced remote control 
operations to control rectifier output.)

Start Time Immediate

Stop Time Never

Output Parameters  Synchronization: Off/On
 Low Output: On

Table 5.  GPS80 Interrupter Factory Default Settings

Setting Description
MicroMax® GPS80 Interrupter Installation & Configuration Guide 13
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C h a p t e r  2

Configuration

Introduction
This chapter explains how to install and use the MicroMax Programmer 
software. You can use the software to monitor the MicroMax GPS80 
interrupter or change interruption settings for Programs 1 through 4. 

The MicroMax Programmer is a Windows-based, configuration software 
that allows you to create an interrupter configuration file and then 
download the file to the MicroMax GPS80 interrupter. You can configure 
interruption cycles using any combination of time intervals between 0.1 
seconds and 99.9 seconds for Off and On cycles. The MicroMax 
Programmer also allows you to configure the MicroMax GPS80 
interrupter with a variety of switches and synchronization configurations; 
open and closed switch configurations are both supported. Every setting 
and parameter is saved in the configuration file for download to the 
MicroMax GPS80 interrupter or for later retrieval.

Installing the MicroMax Programmer 
Complete the following steps to install the MicroMax Programmer 
software on a computer running Microsoft Windows 98 or higher:

1. Insert the BATtools USB drive into an available USB port on your 
computer.

2. Open the BATtools folder and double-click on the executable file 
BatToolsSuiteInstaller.exe.

3. Follow the prompts to install the software. Unless specified 
otherwise, the software installs on your hard drive in the following 
location: C:\Program Files\MicroMax. 

NOTE:  BATtools can also be downloaded from the Asset Tracker 
website (www.bullhornsys.com). Under the Help menu, click the link to 
Support Files for Download and then select BATtools. Once you have 
saved the file to your computer, extract all files and then double-click 
BatToolsSuiteInstaller.exe to install the software and support files.
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Using the MicroMax Programmer
Complete the following steps to begin using the MicroMax Programmer 
software:

1. Connect the MicroMax GPS80 interrupter to your computer using 
the provided interface cable. Connect the other end of the cable in 
an available COM port on your computer. 

2. Start the software by clicking the MicroMax Programmer icon. 

A window similar to the following example displays.

Figure 1.  MicroMax GPS80 Interrupter Programmer

3. By default, the MicroMax Programmer uses COM 1 and 9600 baud 
rate for communication with the GPS80 interrupter. If the GPS80 
interrupter is connected to a COM port other than COM 1, 
complete the following steps:

a. Click File > Options to display the Options window shown 
.in Figure 2.
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Figure 2.  Settings Options

b. To choose a different COM port, click the arrow in the Comm 
Port list box and then select an option from the list. Valid 
choices include COM 1 through COM 18. 

Normal hardware COM ports are COM 1 through COM 4. 
USB converters or other soft COM ports are numbered COM 
5 or higher.

c. To choose a different baud rate, click the arrow in the Baud 
Rate list box and then select an option from the list. 

d. By default, the MicroMax Programmer logs all messages that 
display in the MicroMax Activity pane in a text file on your 
computer in the MyDocuments folder. 

Because this file is typically used for troubleshooting purposes, 
it’s recommended that you not change the Log Messages 
default setting. However, if you do not want to log messages, 
click the Log Messages check box to remove the check mark.

e. To change the name of the log file, type a name for the file in 
the text box below Log file name (no path needed). 

f.  Click OK to save changes and close the Options window. 

4. Complete one of the following steps:

a. If you only plan to monitor the MicroMax GPS80 interrupter, 
turn On the device.

–OR–
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b. If you plan to configure new interrupter program files, 
configure program files first before turning on the MicroMax 
GPS80 interrupter. (There is only a window of 15 seconds 
during which time you can download interrupter program files 
or read data from the MicroMax GPS80 interrupter.) 

NOTE: Before programming the MicroMax GPS80 interrupter, 
ensure that all programs on the DB15 Programming Selection Key 
(dongle key) are switched off (move DIP switches to the right).

Figure 3.  DB15 Programming Selection Key

The MicroMax GPS80 interrupter is ready for programming when 
a message similar to the following example displays in the 
MicroMax Activity pane. 

Figure 4.  Startup Message

If you are monitoring the MicroMax GPS80 interrupter, also refer 
to the section entitled  Monitoring the MicroMax GPS80 Interrupter on 
page 22 for examples of other messages that display in the 
MicroMax Activity pane. 
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Changing Global Settings
1. Review the following general settings information in the Global 

Settings section (Figure 5) as needed: 

• Output Mode: Output parameters are set to accommodate 
various current switch configurations and to enable 
synchronization with other interrupters. The output can also 
be changed to reflect ON as 12V (High) or 0V (Low). 

As a general guideline, when a normally open switch is used, 
the setting should be “Low Output Off”. When a normally 
closed switch is used, the setting should be “Low Output On”. 

• Interruption Cycle Order: The interruption cycle can be set 
to Off/On or On/Off. The setting indicates which part of the 
interruption cycle is executed first on the synchronization 
event. The default setting is Off/On. 

• Time Zone (Standard Times): The time zone can be set by 
selecting from the list of options. All time zones are in 
standard time. The MicroMax Programmer does not allow for 
Daylight Savings Time. If you want to use Daylight Savings, set 
the zone to the zone that is just ahead of your zone.

Figure 5.  Global Settings

Creating Programs
1. To create a new interrupter program, click the arrow next to 

Choose Program and select a program number from the list 
(Figure 6). 
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Figure 6.  Programs

Figure 7, below, shows an example of the Program 4 setting 
options. Currently, the GPS80 interrupter only supports the 
interrupter options. The Program 1 through Program 3 options 
only include Continuous, Start/Stop, and Daily Program types. 
Each program type includes interrupter options applicable to the 
program function. For example, Start/Stop includes a date in the 
Start Time and Stop Time options, but the Daily program type only 
displays time for the Start Time and Stop Time options. Also, the 
Continuous type only uses the On/Off Times option, whereas the 
Always Off type (only available in Program 4) does not allow for 
any options. 

Figure 7.  Program Type and Options

2. Review the following information to create a new interruption 
program:

• Program Type: Choose one of the following program types to 
determine the type of interruption:   

 Continuous: Never stops. The only option available is 
On/Off Times.

 Start/Stop: The start and stop date/time options you 
choose determine when the interruption program begins 
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and stops running. The interruption program runs every 
day during the date and time period you choose using the 
controls in the Start Time and Stop Time group boxes. 

 Daily: The interruption program runs every day during the 
time period you choose using the controls in the Start 
Time and Stop Time group boxes.

 Always Off: This option is only available for Program 4. 
This option sets the interrupter output so that the switch 
connected to it is off when this program is selected. 

• Start Time and Stop Time: These settings are only available 
for the Start/Stop or Daily program types. Sets the time to 
start the interruption. For Start/Stop programs, select a date 
and time from the drop-down menu (Figure 8). For Daily 
programs, click on the hour, minute, or second that is currently 
displayed and then click the up or down arrow to change the 
time (Figure 9).

Figure 8.  Changing Start or Stop Date and Times (Start/
Stop Program)
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Figure 9.  Changing Start or Stop Times (Daily Program)

• On/Off Times: This option cycles power on and off based on 
a time interval you choose. Click the arrows to increase or 
decrease time. You can also type a number in the box.

3. When you finish creating the program file, click File > Save 
Settings to File. 

Sending Programs to the MicroMax GPS80
NOTE: Before programming the MicroMax GPS80 interrupter, ensure 
that all programs on the DB15 Programming Selection Key (dongle key) 
are switched off (move DIP switches to the right). See Figure 3 on page 
18 for more information.

1. If the GPS80 is powered on, turn off the unit and then power on 
the unit.

2. Click the Program Unit button to download the program file to 
the GPS80 interrupter or other type of current interrupter. 

There is only a window of 15 seconds during which time you can 
download interrupter program files or read data from the GPS80 
interrupter. See Figure 4 on page 18 for more details.

Monitoring the MicroMax GPS80 Interrupter
This section includes examples of messages that display in the MicroMax 
Activity pane while using the MicroMax Programmer to monitor the 
status of the GPS80 interrupter. 

NOTE: The MicroMax GPS80 interrupter must be connected to a COM 
port on your computer with the MicroMax Programmer running in order 
to see unit activity in the pane. 
22 Chapter 2. Configuration



Figure 10.  Interrupter in Standby Mode 
Message (No Program Running)

Figure 11.  Interrupter Program 1 
Starting and Running
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A p p e n d i x  A

DB15 Interface

The following table identifies pin function for the MicroMax GPS80 
DB15 interface. The equivalent circuit diagrams are pictured in the 
second section. If you have questions or need additional information, 
contact Technical Support at bhtechservices@aiworldwide.com.
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Table 1.  DB15 Pin Function
 

Only select one program input (Input 1-4) at a time. Open collector / 
drain or NO contacts can be used to control Input 1-4. 

DB15 
pin

Function Circuit Equivalent Comment

1 Power Monitor Power Mon Output Power on indication, ~4V 
when 12V is present

9 Output Monitor DB15 Outputs Interruption signal mon, low 
= 12V at output, hi = 0V at 
output

2 3D Fix DB15 Outputs Satellite OK indication, low = 
OK.

10 Ground

3 Out 4 DB15 Outputs Output confirming Program 
4, low = prog 4 operating

11 Out 3 DB15 Outputs Output confirming Program 
3, low = prog 3 operating

4 Out 2 DB15 Outputs Output confirming Program 
2, low = prog 2 operating

12 Out 1 DB15 Outputs Output confirming Program 
1, low = prog 1 operating

5 not used DB15 Outputs auxiliary output, not used

13 not used DB15 Inputs not used

6 not used auxiliary input, not used

14 Input 4 DB15 Inputs Input 4, activate program 4, 
low = prog 4 selected

7 Input 3 DB15 Inputs Input 3, activate program 3, 
low = prog 3 selected

15 Input 2 DB15 Inputs Input 2, activate program 2, 
low = prog 2 selected

8 Input 1 DB15 Inputs Input 1, activate program 1, 
low = prog 1 selected
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Equivalent Circuits

 

MicroMax® GPS80 Interrupter Installation & Configuration Guide 27



28 Appendix A. DB15 Interface



A p p e n d i x  B

Regulatory Notices

The following FCC requirements are met by the product(s) described in 
this guide.

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will 
not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:

1. Reorient or relocate the receiving antenna.

2. Increase the separation between the equipment and receiver.

3. Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

4. Consult the dealer or an experienced radio/TV technician for help.
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